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Digital 
Dentistry 
Your Way

 

 
Henry Schein ConnectDental®, Henry Schein’s 
platform for digital dentistry, integrates a wide choice 
of innovative, scalable digital technologies into every 
step of the clinical workflow. We are committed to 
helping you:

• Enhance the patient experience 
• Deliver predictable, quality dentistry 
• Improve efficiency and productivity

Making the right solutions work for you. 

Practice Management Software
Clinical Treatment Software

Laboratory Software
Patient Marketing

Patient Education Software
2D/3D Imaging

Intraoral Cameras

Scanners
Milling Units
3D Printers
CAD/CAM Materials
Dental Implants
Orthodontic Solutions
Computer Network Solutions

For more information about our Henry Schein ConnectDental Trusted 
Digital Solutions, please contact your Henry Schein Dental Sales 
Consultant or call 800-890-8153 for full product information.
www.henryscheindental.com
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Become a Dentrix

KNOW-IT-ALL!
Dentrix Mastery Tracks™ online training

will help you become the Dentrix 
KNOW-IT-ALL your o�ce needs!

Mastery Tracks training will help your team members better prepare 
to use Dentrix on the job—in just a matter of days. Team members 

can learn the essential components of Dentrix, allowing them to be 
more e�ective right away. Even long-time employees can benefit 

from a great refresher. And, for team members ready to expand and 
deepen their skills, Dentrix Mastery level training is also available.

Mastery Tracks online training is included with your Dentrix 
Customer Service Plan. So, what are you waiting for? Become the 

team KNOW-IT-ALL today!

Take advantage of all that  
Dentrix Mastery Tracks has to o	er.

Log in at Dentrix.com/resource-center 
and select “Get Your Training.”
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CHUC NGUYEN | REGISTERED DENTAL HYGIENIST

Dentrix Mastery Tracks

SPOTLIGHT

Where do you work?

Cambridge Dental, Inc. in Houston, Texas

What is your title?

Registered Dental Hygienist

What are some of the duties you’re responsible for 
within your practice?

At our practice, I perform dental prophylaxis and periodontal 

maintenance, scale and root plane, apply sealants, take 

impressions for occlusal guards/bleaching trays, take 

radiographs, enter and present treatment plans, work on recall, 

order supplies, and train new staff members on clinical tasks like 

treatment planning and clinical notes. 

How long have you worked with Dentrix?

I have worked with Dentrix for over nine years. 

Which certificates have you earned?

I have earned the Dentrix Clinical Specialist certificate.

What got you interested in Dentrix Mastery Tracks?

When our office transitioned from Easy Dental to Dentrix, I 

wanted to familiarize myself with the clinical aspects of Dentrix 

so I could customize the procedure code setup and clinical note 

templates to make it easier for the clinical staff and the doctors. 

How has participating in Mastery Tracks helped you  
use Dentrix?

Completing the Clinical courses and tests allowed me to 

be more confident in navigating Dentrix. Now if I have any 

questions, I know exactly where to find my answers.

How has becoming a Dentrix specialist improved  
your career?

By becoming a Dentrix specialist I was able to use my 

knowledge to help the team be more effective and efficient, 

creating a better experience for the patients. I have helped to 

shorten the time for the clinical staff to create treatment plans 

and complete clinical notes, and now they can to do it more 

thoroughly with fewer clinical errors.

What is your favorite Dentrix tip or trick?

My favorite Dentrix trick is to create and customize clinical note 

templates for each provider. This has allowed the clinicians to 

be very detailed with their clinical notes and save time with 

documentation.

Dentrix Mastery Tracks™ helps dental professionals 

improve, measure, and demonstrate their Dentrix skills. 

Read on to find out about Chuc Nguyen, a hygienist 

who has completed two Mastery Tracks tests and 

earned one specialist certificate. 

Take a course. Take a test. Earn a certificate.

 Visit Dentrix.com/Mastery and start using Dentrix Mastery Tracks to  

help your team improve, measure, and demonstrate their Dentrix skills.
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 Announcing New Insurance Payor Connections
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Dentrix has eClaims connections with several new payors. 
For patients using the following insurance carriers, you 
can reduce paper claims by submitting electronic claims 
through Dentrix instead. 

Payor ID	 Payor Name

37322		 Companion Life/KHP

37321		 Fidelity/ Key Select

61453		 Kemper Benefits

81502		 Prime Health Choice

For more information about Dentrix eClaims, visit  
www.dentrix.com/products/eservices/eclaims. 

 

The following payors now accept electronic claim 
attachments. With electronic attachments, you can add 
digital X-rays, EOBs, photos and perio charts to the 
electronic claims you send. 

Payor ID	 Payor Name

BEAM1 or CXBMD	 BEAM Dental Insurance

BEAM1 or CXBMD	 Beam Insurance Administrator

BEAM1 or CXBMD	 BIA

BEAM1 or CXBMD	 BIA/BEAM 

BEAM1 or CXBMD	 First Dental Health/BIA 

For more information about electronic insurance claim 
attachments, visit www.dentrix.com/products/eservices/
eclaims/attachments. 

Insurance Manager allows you to verify insurance eligibility 
in real time or to perform automatic insurance eligibility 
uploads. You can now verify patient insurance eligibility 
electronically with the following payors.

Payor ID	 Payor Name

11271		 HealthPlex

For more information about automated insurance eligibility 
verification or to register, visit www.dentrix.com/products/

eservices/ecentral/insurance-manager. 

After you have sent claims and attachments to payors 
electronically, complete the electronic claim round trip by 
accepting electronic explanation of benefit statements 
(eEOBs) that the insurance carrier sends back to you. The 
following payors now send eEOBs.

Payor ID	 Payor Name

88888		 Dentegra

For more information about eEOBs or to register, visit 
www.dentrix.com/products/eservices/eclaims/eeob. 

View the entire list of electronic payor connections using 
the Payer Search Tool at www.dentrix.com/products/
eservices/eclaims/payor-search. You can search for 
specific payors or download the complete payor list. 

Call 800-734-5561 for help setting up any of these services.

eClaims

Attachments
InsuranceManager

 Important Payor Notifications

The following payors have released important notifications 
about their plans. 

Medicaid of Arkansas (Payor ID: CKAR1) Trading Partner 

Update
As of October 20, 2017, Medicaid of Arkansas now 
requires providers to associate themselves to HSPS’s 
Vendor Partner “Change HealthCare” Trading Partner ID of 
TP010036 for EDI claim delivery. You may complete this 
step by calling Medicaid of Arkansas Systems at 800-457-
4454, Opt. 0, Opt. 1 for the EDI Helpdesk.

Principal Financial Group (Payor ID: 61271) Member IDs
To ensure the protection of member’s personal information, 
do not submit claims using their Social Security numbers. 
Use the member ID located on the member’s dental 
insurance card which typically begins with a “9” and is nine 
digits long located on the dental insurance card. Claims 
submitted with a Social Security number or incorrect 
member ID will be rejected by the payor.



 Dentsply Sirona Joins the Henry Schein Family

On September 1st, Henry Schein announced an exciting 
new relationship to offer Dentsply Sirona products to our 
customers. Along with that announcement, the Dentrix 
team announced the following opportunity for Dentrix 
users who plan to purchase Sirona technology through 
Henry Schein Dental before the end of 2017:

Sirona SIDEXIS 4 Bridge for DTX G5.2 +, a new Dentrix 
bridge, is now available at no additional charge through 
December 28, 2017, for Dentrix users who purchase one 
or more Sirona sensors and scanners through Henry 
Schein Dental. To qualify, Dentrix users must also purchase 
the appropriate Henry Schein Sirona Support Club for 
their product and have a current Dentrix Service Bundle 
(Essentials, Momentum, or Optimum).

The Sirona SIDEXIS 4 Bridge for DTX G5.2 + is also 
available for purchase directly from Henry Schein Practice 
Solutions at an MSRP of $995. For information for either 
offer for the SIDEXIS 4 Bridge, call 844-633-8998. 

Dentrix does
All THAT?

50 Things You 
Didn’t Know 
Dentrix Could Do

Register for a Spring 2018 Insight Seminar TODAY! Seating is limited.
www.Dentrix.com/InsightSeminar or call 866.367.2711
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Learn about the upcoming Health History 
module, enhanced imaging integration,  
and more!

I 
can’t believe that 2017 is coming to an end! This year we 

were able to bring you updates on a regular basis with 

additional features and enhancements to assist you in 

delivering great patient care. Through User Voice, we have 

received continuous feedback from you on other areas of 

improvement. We look forward to incorporating many of 

those items into the product. In fact, I would like to take the 

opportunity to tell you about some of the updates you can 

expect in 2018.

Health History

Have you ever dreamed of a single module to manage 

allergies, conditions, and medications that didn’t limit you 

to 64 discrete definition types and could pop up in different 

areas of the application depending on severity? How about 

having it tightly integrated with patient questionnaires so 

that responses on the questionnaire would flow into this 

module without manual entry? Even more, what about 

a place to capture the patient’s emergency contact and 

primary care physician’s information? 

Great news! All of this will be coming in phases in 2018 as 

part of our new Health History Module. In addition to these 

amazing updates, you will have the ability to show the 

date that items were reported to the office, when they first 

surfaced for the patient, and, if applicable, when they are no 

longer active (such as pregnancy). Each patient’s medication 

information will show those that are prescribed by your 

office and give a place to list medications that have been 

prescribed to your patients by others.

Enhanced Imaging Integration

We have greatly enjoyed our partnership and integration 

capabilities with DEXIS. However, the market has evolved 

with respect to distribution agreements for the various 

imaging vendors. With that in mind, we will soon be 

expanding Dentrix imaging integration with other vendors 

and tools into the Dentrix Patient Chart. In addition, we will 

offer enhanced integration capabilities that go beyond what 

is available today. Stay tuned for more on these exciting 

imaging enhancements.

Upcoming Changes that You Can Prepare for Now

Operating System Requirements - In the Spring 2017 issue of 

Dentrix Magazine, I discussed changes to Microsoft operating 

system requirements with Dentrix, including the use of our 

eServices. I stated that we will no longer be able to process 

transactions that come from any unsupported Microsoft 

operating systems. The reason is that these operating 

systems cannot send data using the latest transport layer 

security (TLS) version of 1.2 or higher but instead submit 

using older, outdated methods. 

Many of our eServices have officially been moved over to use 

the latest transport layer security (TLS) version of 1.2. What 

is important to note is that as of Dentrix G6.6 (coming soon), 

only the following operating systems are supported with 

Dentrix:

Servers

•	 Windows Server 2016

•	 Windows Server 2012 Standard/Datacenter (R1/R2)

•	 Windows Server 2008 Standard/Enterprise/Datacenter 
(R2 SP1)

Workstations

•	 Windows 10

•	 Windows 8.1 Professional/Enterprise

•	 Windows 7 Professional/Enterprise/Ultimate (SP1)

Dentrix Passwords

In the Winter 2014 winter issue of Dentrix Magazine, I 

discussed multi-layered security practices. As part of that 

article, I discussed one important first line of defense that 

should be coupled with all other industry standard and 

best practice security requirements: passwords. As such, in 

a release of Dentrix in 2018, it will now be required to use 

passwords in Dentrix, and those passwords will employ 

today’s standards for complexity and expiration. 

In anticipation of that release, please start today by ensuring 

that your passwords are enabled and that all users have 

appropriate access to the various areas of Dentrix. You can 

also start using the appropriate complexity requirements 

for that upcoming release now. Those requirements will be 

a minimum of eight characters with at least one uppercase 

and lowercase alpha character, at least one numeric 

character, and at least one special character (such as 

#@$*); or passwords with a 12 character minimum. Again, 

this should not be the only line of defense. We highly 

recommend that you work with both computer and security 

policy experts to implement safeguards based on industry 

standards and best practices. 

I am very excited about the future as we continue to partner 

together to continuously improve upon the great foundation 

of Dentrix. If you have any questions or would like to suggest 

areas of improvement in the product, please don’t hesitate 

to reach out to me at brad.royer@henryschein.com.  
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What’s Coming in 2018

BRAD ROYER
Dentrix Product Manager
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Consider It Done.

Service Bundles

Call your account 
executive today at 

844.852.3155 to
get your Dentrix 

Service Bundle now.

Learn more at: 

Dentrix.com/ServiceBundles

As an office manager, you’re 

expected to do it all—scheduling, 

billing, insurance, appointment 

reminders and more—while 

keeping production up and costs 

down. We’d like to give you a 

hand. Our Dentrix Service 

Bundles are packed with 

eServices—powerful tools 

connected to Dentrix that help 

boost your front office 

productivity and streamline

your workflow. Now you can

automate the tasks you

shouldn’t be doing manually. 

Done and done. Bundle your 

eServices and save!



 
Integrate your lab case 

management and intraoral
scan casework deeply 

into your Dentrix workflow.

Improve 
practice 

efficiency 
and patient 

care with 
DDX.

To enrol or get more information,  
visit www.ddxdental.com or call 800-244-9345.
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Printing Care Instructions with Walkout Statements
From 15 Dentrix Procedure Code Tricks You Need to Know

When patients have oral surgery or other difficult 

procedures completed in your office, you often have care 

instructions to send home with them. You can attach those 

care instructions to specific procedure codes. Then, when 

you complete that procedure code, the care instructions will 

be automatically printed along with the walkout statement 

you generate for the patient.

1.	 Create a document that contains the care instructions 

you want to give to patients and save it in your Dentrix 

letter template folder.

2.	 In the Office Manager, click Maintenance > Practice 

Setup > Procedure Code Setup, select the procedure 

code you want to attach the instructions to, and  

click Edit.

3.	 Click Edit Note.

4.	 In the Recommendation Note group box, click the 

Recommended Documents search button, select the 

document you want to attach to the procedure code, 

and click OK.

5.	 Check Print Note on Walkout to include that 

document when you print a walkout statement  

that includes in the completed procedure code.

Additional Tips

•	 If you don’t know the location of your Dentrix 

letter template folder, you can find it in the Office 

Manager by clicking Maintenance > Practice Setup > 

Preferences and clicking the Paths tab. 

Searching for Payments in Dentrix
From Dentrix Ledger Basics

It would be nice to have every piece of information available when you 

need to find a payment in Dentrix, but that isn’t always the case. For 

instance, a patient tells you they made a payment, but it is not posted 

on their account. You need to find out where that payment was posted 

so you can correct the error, but you only have the payment date and 

the payment amount to work from.

Luckily, the Search Payments utility lets you perform a search with 

whatever information you have available without having to manually 

look through individual patient accounts or running reports. 

1.	 From the Ledger, click File > Search Payments.

2.	 Enter the search criteria you have available to find the payment(s). 

Click Search. Payments matching the criteria will be listed.

3.	 Double-click any payment in the list to open the Ledger for that 

patient so you can view the payment in more detail.

Additional Tips

•	 You can combine several search criteria (check number + date, or 

payment type + amount, for example) for a more precise search 

with fewer results.

•	 In the search results, click any column header to sort the results 

by that column. Or click and drag the column header to rearrange 

the columns.

•	 To learn more, view the Search Payments video or read Searching 

Payments in the Dentrix Help.

Clinical

Financial

These tips from Dentrix software courses at the 

Business of Dentistry conference simplify workflow 

and increase efficiency. Find the tips that correspond 

to your role in the practice. Start making your job 

easier and your practice more profitable today. 

Tips
&Tricks
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Copying Procedure Notes to Clinical Notes
From 15 Dentrix Procedure Code Tricks You Should Know

After each appointment, the clinical providers in your office spend several minutes writing detailed, 

accurate clinical notes. It would save a lot of time to not have to write all of the notes from scratch. Did 

you know that many procedure codes in Dentrix already have procedure notes written that can be copied 

and used as part of your clinical notes? Instead of taking the time write all that information again, get a 

head start by copying the information that’s already in the procedure notes to your clinical notes and 

then making edits and additions as needed.

1.	 From the Office Manager, select Maintenance > Practice Setup > Procedure Code Setup.

2.	 Select the procedure code category and individual procedure you want to edit, and click Edit.

3.	 Click Edit Note.

4.	 Edit the procedure note text as needed, select the Copy to Clinical Note option, and click OK.

5.	 Click Save, verify that you want to save your changes, and then click Close.

6.	 Repeat for other procedure codes as needed.

Additional Tips

•	 Whenever the procedure is posted complete for a patient, the procedure note appears as the clinical 

note on that date. You can edit the clinical note and make changes or add additional information as 

needed.

•	 Not all procedures in the Procedure Code Editor will have procedure notes by default. You can add 

or edit the procedure notes for any procedure and then select the Copy to Clinical Notes option.

•	 When you set complete a procedure code that requires a tooth number, surface, quadrant, or other 

treatment area information, that information will automatically be added to the beginning of the 

clinical note text. For example, if the procedure code note read “Filling of a cavity.” When you set 

complete the procedure, the clinical note will read “Tooth: 3 Surface: O Filling of a cavity.”

•	 To learn more, read Editing Procedure Notes in the Dentrix Help.

Practice Analysis
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Reactivating Archived Patients
From Dentrix Family File Basics

Sometimes patients who have been away for several years move back into the area and come back to your practice. If you 

archived these patients and they return to your practice, you can easily reactivate them in Dentrix. When you reactivate the 

patient, their address, procedures, insurance claims, payments, adjustments, medical alerts, prescriptions, patient questionnaires, 

and periodontal exams are all restored.

1.	 From the Family File, open the Select 

Patient dialog box and check Include 

Archived Patients.

2.	 Select the archived patient you want to 

reactivate and click OK.

3.	 In the Family File window, double-click the 

Patient Information block.

4.	 Click OK to the message that appears. 

Dentrix will change the patient status to 

Patient.

Additional Tips

•	 The Include Archived Patients checkbox 

option is only available when selecting a 

patient from the Family File.

•	 When an archived patient is reactivated, 

view the Patient Notes to see information 

regarding their previous continuing care, 

employer, insurance, and referral settings 

(if any).

•	 To see a list of all archived patients,  

generate the Archived Patient List. From  

the Office Manager, select Reports > Lists >  

Archived Patient List and enter filtering 

criteria to generate the list.

Front Office

Emailing a Document from the Document Center 
From 10 Dentrix Document Management Tips

One of your patients called this morning and asked for a copy 

of his most recent billing statement and the EOB for his last 

insurance payment. If you are using the Document Center to 

store patient documents, you can simply select the requested 

documents, open an email message from Dentrix (which 

automatically adds the document as an attachment), and send 

it to the patient via email.

1.	 Open the Document Center and select a patient.

2.	 From the Document Tree, select the document you want 

to send.

3.	 Click File > Send Document(s). Your email program will 

automatically open with the following attributes:

•	 The To address field will have the patient’s email 

address (if one is store in the Family File).

•	 The Subject field will be populated with the 

document’s description.

•	 The document’s description will also be used for the 

attached file name, along with the document’s type 

(PDF, JPG, etc.) and file size.

•	 Any notes from the Document Information dialog 

box will be included in the main body of the message 

(which you can edit before sending).

4.	 Add text to the body of the email as needed and click 

Send to send the message.

Additional Tips

•	 To email a document from Dentrix, your computer  

must be running a MAPI-compliant email software  

such as Microsoft Outlook or Outlook Express. Web-

based mail accounts, such as Gmail or Yahoo Mail, do  

not work with Dentrix.

•	 If MAPI-compliant software is not installed or your 

practice uses a web-based solution, you can export 

the document and then attach it to an email. (Open 

the Document Center, select the document from the 

Document Tree, and click File > Export Document(s). 

Save the document to your computer and then attach  

it to your email.)

•	 You may want to record the correspondence in the 

patient’s Office Journal, as Dentrix does not do this 

automatically.

•	 To learn more, read Sending Documents Electronically 

and Exporting Documents as Files in the Dentrix Help.

Front Office
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Tips for Setting Up Various Types of Families in Dentrix 
From Managing Complex Family Situations in Dentrix

Not all families are the same, which means that not all families will be set up in Dentrix the same way. When some 

members of a family are patients but the guarantor is not or when a child has insurance coverage through divorced 

parents, you can adapt the way you set up that family in Dentrix to reflect that family’s situation. 

Here are a couple of family situation scenarios and how you should set them up in Dentrix:

Scenario 1: Parent A and Parent B do not live together. Child lives with parent A (who is the child’s responsible 

party) but Parent B is an insurance subscriber for the child. Parent B is not a patient.

1.	 Enter Parent A as the Head-of-Household. Enter Parent A’s mailing address as his or her address record.

2.	 Add Parent B to the account as the insurance subscriber. When creating the record, leave the SS# field blank 

and set his or her status to Non-patient, Other. Enter Parent B’s mailing address as their address. Add the 

insurance coverage information.

3.	 When creating the child’s record, select the address to match the parent who is responsible for dealing with 

treatment correspondence from the dental office (in this situation, Parent A).

4.	 Attach Parent B’s insurance coverage to the child.

Scenario 2: Parent A and Parent B do not live together, but they are both active patients. Child lives with Parent A, 

who is the responsible party for the child. Parent B is the insurance subscriber for the child.

1.	 Create Account #1. Enter Parent A as the Head-of-Household. Set his or her status to Patient. Enter the mailing 

address as his or her address record.

2.	 Enter Parent B as the insurance subscriber. When creating the record, leave the SS# field blank and set his or 

her status to Non-patient, Other. Enter their mailing address as the address record.

3.	 Add the child’s record to Account #1, select his or her address to match the parent who is responsible for 

dealing with treatment correspondence from the dental office (in this situation, Parent A). Attach parent B’s 

insurance coverage to the child.

4.	 Create Account #2. Re-enter Parent B. When creating the record, enter the SS# (if desired) and set his or her 

status to Patient.

Scenario 3: Parent A and Parent B do not live together. Child lives with Parent A, but Parent B holds the insurance 

and receives the bills for the children.

1.	 Enter Parent B as the Head-of-Household for the child’s account. When creating the record, leave the SS# field 

blank and set his or her status to Non-patient, Other. Enter the mailing address as his or her address record. 

Enter the insurance information.

2.	 Add the child to Parent B’s Non-patient, Other account. When creating the child’s record, enter his or her 

address to match the parent who is responsible for dealing with treatment correspondence from the dental 

office (in this situation, Parent A).

3.	 Attach parent B’s insurance coverage to the child.

4.	 Enter Parent A as another member of the family, with a mailing address that is different from Parent B, but that 

matches that of the children.

Scenario 4: Parent A and Parent B do not live together. Child lives with parent A and Step-parent A. Parent B and 

Step-parent A are both insurance subscribers.

1.	 Create an account for parent A and stepparent A. Make sure parent A is the head of household for the account.

2.	 Add the children to parent A’s account.

3.	 Add insurance to stepparent A.

4.	 Add parent B to the child’s account as a non-patient. Add insurance for parent B.

5.	 Determine which insurance should be primary for the children.

•	 If the parents have a court order determining which parent provides insurance for the children, follow the 

court order in assigning insurance to the children.

•	 If insurance is not determined by a court order, then follow the birthday rule in assigning insurance to the 

children. (Primary insurance follows the subscriber with the earliest birthdate in the year).

6.	 Assign insurance to the child as appropriate.

Keep in mind that with complex family situations, you can always enter explanatory information about the family 

dynamics in the Patient Note within the Family File.

Front Office
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Assigning a Specific Provider for Continuing Care
From Why Isn’t Your Dentrix Continuing Care System Working?

When you have multiple hygienists in your office, it’s common for patients to prefer one 

hygienist over the other. For example, one of your patients was recently seen by HYG2 for 

a prophy appointment. The patient appreciated how the hygienist listened to his concerns 

and her gentle touch when cleaning his sensitive teeth, and he would like to continue 

to see that hygienist for future appointments. You can accommodate requests like this 

and set up a specific provider for continuing care appointments as part of assigning a 

continuing care type. That way, when you schedule a prophy appointment, the patient’s 

preferred provider is attached by default.

1.	 From the Family File, select a patient and double-click the Continuing Care block.

2.	 Select the prophy continuing care type from the list (or select the perio type if the 

patient is on perio maintenance), and click Edit. 

3.	 In the Provider group box, select the provider the patient wants to perform their 

continuing care.

•	 Prov1 - Continuing care appointments default to the patient’s primary provider (as 

selected in the Family File).

•	 Prov2 - Continuing care appointments default to the patient’s secondary provider.

•	 Spec - Continuing care appointments default to the specific provider you select in 

the drop-down list.

4.	 Click OK. When an appointment is scheduled for the continuing care type, the 

specific provider attached to the continuing care type is listed as the appointment 

provider in the Appointment Information dialog box.

Additional Tips

•	 When scheduling appointments, you can still manually change the provider/

additional provider for the appointment in the Appointment Information dialog box 

as needed.

•	 To learn more, read Editing Continuing Care Types in the Dentrix Help.

Clinical



Requiring a Pre-Authorization for Specific Procedures
From Estimate or Guesstimate? Getting Insurance Estimates Right in Dentrix

Occasionally, insurance companies require you to submit a pre-authorization for a procedure before the 

work is completed. Because these requirements vary from insurance company to insurance company, you 

can manipulate the coverage table for each insurance company in Dentrix and mark the procedures that 

require pre-authorizations.

1.	 In the Office Manager, select Maintenance > Reference > Insurance Maintenance.

2.	 Highlight the insurance plan you want to update, and click the Coverage Table button.

3.	 Select the procedure (or procedure category) that requires a pre-authorization.

4.	 Check the Pre Auth checkbox, and then click Change. A “Y” will appear in the Pre Auth column. When 

that procedure is treatment planned for a patient, a notation is added to the Treatment Plan view of 

the Ledger and the Case Detail view of the Treatment Planner.

5.	 Click OK to save the changes.

Additional Information

•	 You should make it a habit to update the coverage table when insurance companies notify you of 

procedures that require pre-authorization. Then as procedures are treatment planned for patients, 

double-check the Treatment Planner view of the Ledger for which procedures need authorized before 

treatment.

•	 In the Treatment Planner, click View > Procedure Information and make sure that the Pre Auth option 

is checked. Then when you use the Treatment Planner Case Detail view, you will be able to see whether 

a pre-authorization is needed before you complete the procedure.

•	 When viewing the Treatment Plan view in the Ledger, procedures needing pre-authorization display 

the following information in the Ins column to indicate what kind of pre-authorization is required:

-	 1** - Indicates primary insurance requires a pre-authorization on that procedure.

-	 2 - Indicates secondary insurance requires a pre-authorization on that procedure.

-	 1*2 - Indicates both primary and secondary insurance require a pre-authorization on the procedure.

-	 NO - Indicates neither insurance requires a pre-authorization on the procedure.

Financial

Follow Dentrix on Facebook to 

get tips like these every Tuesday! 
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The Dentrix Business of Dentistry Conference is all about 

your business and how to make it better organized and 

brilliantly productive, with bigger opportunities and a 

bottom line that makes work worthwhile. This year’s 

conference was held August 17 – 19 at Caesar’s Palace in 

the heart of the Las Vegas Strip. 

Conference attendees interacted with more than 40 dental 

industry consultants, trainers, executives, and influencers. 

They enjoyed in-depth training and technology previews, 

learned tips and tricks to streamline processes, and 

explored business strategies to build a more successful 

dental practice. And, best of all, attendees discovered 

actionable insights to take home and put right to work 

in their practices.

If you attended the conference, read the following 

summaries to review some of the key takeaways from 

some of the most popular speakers and courses. If you 

didn’t attend, read these summaries to get a sample of 

the valuable continuing education content delivered at 

the conference, and then use the recommendations in 

this article to set your business up for amazing growth 

and heightened potential.

If you like what you read, we invite you to join us for the 

next Dentrix Business of Dentistry Conference. We’ll be 

at Caesars Palace August 22 – 24, 2019. Put it on your 

calendar today! 

Advice from Industry 
Experts at the 2017 
Dentrix Business of 
Dentistry Conference

Read key takeaways from some 
of the most popular speakers and 
courses at this year’s conference.
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Creating the Ideal Service Culture in your Practice
Amy Morgan, Chief Executive Officer, Pride Institute

Many dentists and their team members are worried about increased competition, corporate 

dentistry, insurance participation, or economic challenges. The question they most often ask is: Can 

we continue to not only survive, but be successful? 

The answer is simple but oh-so-difficult to implement! If you want to thrive in a challenging 

environment, then the solution is to focus on your customers. 

Customers who are completely satisfied are—to a surprising degree—much more loyal than satisfied 

customers. Patients will only remain rock-solid if they are completely satisfied. Satisfied patients will 

leave if they feel there is a viable choice between dentists1.

Think about brands like Disney or Ritz-Carlton. Their success comes from creating a service culture 

and experience that is designed to completely satisfy. Where can you start to create that kind of 

service culture in your practice?

•	 Create a customer service vision statement/credo. Make sure it includes the quality of your 
service and outcomes, how each team member interacts with your patients, and why team 
members should WANT to go above and beyond.

•	 Once you have the vision, walk your talk! Create the “systems beyond the smiles” as per 
the Ritz Carlton’s Gold Standards. The heart is the only place service comes from. How are 
you going to engage and empower your team to engage your patient’s hearts? This has to 
include anticipation and fulfillment of your patients’ needs and desires.

•	 Engage and empower your team! Follow the Ritz promise, “By applying the principles of 
trust, honesty, respect, integrity and commitment, we nurture and maximize talent to the 
benefit of each individual and the company.”

If you can’t honestly say that, if asked, your patients (or your team) couldn’t imagine a world without 

you, then focusing on expanding your service culture has to be your goal!

Amy Morgan is CEO of Pride Institute, a nationally acclaimed results-oriented Practice Management consulting 

company. Amy and her team of highly qualified consultants have revitalized thousands of dental practices using 

Pride’s time-proven Management Systems, resulting in dentists becoming more secure, efficient and profitable. 

Pride Institute, founded in 1974, is dedicated to substantially improving doctor’s professional, financial and 

personal lives. Specifically, Pride has taught over 20,000 dental offices how to excel in effective Leadership, 

Staff Management, Treatment Presentation, Scheduling, Patient Financing, Cash Flow/Goal Setting, Social and 

Traditional Marketing and Transition Strategies.

1 https://hbr.org/1995/11/why-satisfied-customers-defect

DENTRIX MAGAZINE | 17



18 | www.Dentrix.com/Magazine

Managing Employee Performance in a More  
Effective and Contemporary Way
Tim Twigg, President, Bent Ericksen & Associates 

With a stronger and expanding economy, the labor market for good employees 

is getting increasingly tighter. Employers must now pay attention to long-term 

retention, reducing turnover, and improving employee engagement.

Today, your systems are only as good as the people running them. An engaged 

workforce represents the true competitive advantage in the marketplace. Why? 

Because dental practices are in the customer/patient service business, and to 

deliver high quality service, you need an engaged team.

Improving performance management begins with clarifying and communicating 

your vision and values. Next comes the work of establishing an organizational 

culture with employees. Create a culture where employees:

•	 Can and will think

•	 Are supported and given permission to think (within the context of your 
vision, mission, purpose, and values)

•	 Are allowed to make mistakes, which are opportunities for learning and 
growth

When employees are valued for their brain, they stay; they are more committed 

and engaged.

A fundamental requirement for successful performance management and 

employee engagement is trust. Trust is built by:

•	 doing what we say we are going to do

•	 demonstrating respect

•	 extending trust

An effective tool for building employee engagement and improving performance 

is goals. Goals are future-focused and foster individual and/or organizational 

improvement. Enlisting employees in the goal-setting process allows for greater 

ownership and accountability. 

Sharing your success through bonus and incentive plans is also an integral part of 

performance management. Bonus plans help to:

•	 Objectively reward growth and financial success

•	 Lead to greater team/staff satisfaction

•	 Reduce staff money-related stress

When these elements are successfully implemented, you can expect a stronger, 

happier workforce that will enhance your business and reduce your stress—a win-

win for everyone!

Tim Twigg is the President of Bent Ericksen & Associates. For over 30 years, Bent Ericksen 

& Associates has been the “go-to” resource and leading authority in human resources, 

employment compliance and personnel management in the healthcare industry. Tim is a 

published author and currently co-authors a regular column in Dental Economics. He is part 

of the management faculty and/or speakers’ bureau for: Career Fusion, Seattle Study Club, 

Jameson Management, and the Dental Business Institute. Tim is the past president of and a 

member of the Academy of Dental Management Consultants and a member of the Speaking 

Consulting Network.
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Insider Perspectives: State of the Dental Industry
Teresa Duncan, MS, FAADOM and  

Kevin Henry, Co-founder, Igniteda.net

Our industry is in a state of flux that surpasses any other time in dental history. It 

can be a tough time to be a dentist or dental team member; however, it is possible 

to overcome obstacles and make this year the best your practice has ever seen. The 

best thing you can do to prepare for the future is to understand what’s really happening in 

dentistry and what trends you should pay attention to.

Dental teams are changing

According to the American Dental Association, in 1950, there were approximately 155,000 

people working in the dental practice, which included dentists, hygienists, assistants, 

front desk personnel, and other team members. At the time, just over 50 percent of these 

individuals were dentists. By the time 2012 arrived, the total number of dental personnel had 

skyrocketed to almost 1 million. While the number of dentists has remained relatively steady, 

the proportion of team members to dentists has grown exponentially.

What does this mean for you? Invest some more time in leadership so that you can lead 

these new team members who are driving your practice toward either success or trouble. 

You set the tone for your practice so invest in yourself and see the rewards pay off.

How much are dentists working?

According to the ADA Health Policy Institute, in 1990, general practitioners worked on 

average 1807.8 hours per year. Based on eight-hour days, that’s 225.98 days per year. That 

has decreased dramatically. In 2014, general practitioners worked, on average, 206.41 days 

per year.

Some of the reasons for this are more experienced dentists moving to part-time roles, 

younger dentists entering group practices, dental practices being open fewer hours, and 

more dentists wanting to focus on family and non-dental priorities.

Could your practice benefit from a split schedule and dentists sharing hours? Perhaps. It 

may fit your schedule better and offer more opportunities for patients to visit your practice 

when it’s best for them. Flexibility for both employees and patients will play a bigger role in 

your staffing decisions.

Insurance impacts are immense

Dentists are feeling the effects of changing plan designs and consumer behavior. Increased 

frustration and extended time before retirement are a direct result of these external market 

forces. Expect stricter plan designs in the future along with an increase in documentation 

requirements. The quality of your documentation will drive your revenue in the future. With 

upcoming diagnostic coding changes that will affect the general dentist, forward-thinking 

teams will start preparing now by inspecting and improving their systems. 

Changes are in process now that require a watchful eye on your practice. Being in the dental 

business requires awareness, flexibility and optimism. Success will come to those who can 

balance all of this!

With over 20 years of healthcare experience, Teresa addresses topics such as Insurance Coding, Office 

Manager Training and Revenue Growth and Protection. Her memberships include the National Speakers 

Association and the Academy of Dental Management Consultants. She was recently named one of the 

Top 25 Women in Dentistry. Teresa received her Master’s Degree in Healthcare Management.

An advocate of today’s dental assistant, Kevin Henry speaks to dental audiences across the nation on 

topics that empower dental assistants, helping them recognize the leadership role they hold in the prac-

tice. Kevin is the former managing editor of Dental Economics and currently serves as the co-founder 

and thought leader for IgniteDA.net. 
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Dental Marketing Made Easy: Using  
Social Media to Get the Best Patients
Tom Clark, Banyan Founder 

Social media is the new word of mouth for dental marketing. 

Since 68% of all U.S. adults use Facebook , it’s important for you 

as a provider to have a strong presence where your patients hang 

out. The challenge is knowing how to put social media to work 

for your practice.

Practices who succeed on social media post quality content 

on a consistent basis. They understand that the most engaging 

posts are of patients and staff members celebrating moments 

that matter together. For example, dentists can celebrate a no-

cavities patient exam by taking a photo with a happy child and 

her mother, posting the photo on the practice’s Facebook page, 

and inviting the mother to share it as well. However, photos and 

social media posts must never compromise patient privacy. That’s 

why it’s vital for practices to honor HIPAA rules in the process of 

expanding their reach online. 

Patients who feel like their doctors genuinely care about them as 

people are more likely to post social media photos and reviews 

online. Building these trusted relationships gives practices a 

significant advantage over practices that rely on a traditional 

approach to patient referrals.

It used to be that satisfied patients waited until a friend or 

family member asked them for a referral before recommending 

a provider or practice. Even the most supportive patients may 

have gone months without saying something positive about 

your practice, depending on whether someone asked them for 

a referral. Social media activates patient goodwill as it happens. 

Now your practice can turn satisfied patients into advocates in 

real-time. This is significant since patient posts allow you to tap 

into their trusted circle of friends and family.

Implementing these concepts requires doctor/owner buy-in and 

a coordinated effort from all staff members. Daily team huddles 

should include a discussion about patient appointments and 

who is most likely to provide a social media post and review. 

Technology alone isn’t transformative. Adopting the right 

behaviors—combined with the right technology—impacts your 

practice in a positive way.

As the founder of Banyan, Tom Clark believes that the most effective 

healthcare providers deserve the best patient relationships. With this idea 

in mind, Tom created the industry’s first HIPAA-compliant social media 

app to help doctors connect with patients online. In addition, the company 

now offers digital marketing, reputation management and patient 

communications solutions. Prior to Banyan, Tom was president and CEO 

of WhiteCap Dental Solutions, achieving a three-year growth rate of 625 

percent. When he’s not building businesses, Tom enjoys spending time 

with his family and boating.
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The Magic of Effective Communication
Lois Banta, President, Banta Consulting 

The most important aspect of dentistry today is not what you say to patients and insurance companies, but 

how you say it. 

The key elements for effective communication are very simple. 

1.	 Don’t ask Yes/No questions

2.	 Always offer two options,

This method works well in every patient communication scenario, from presenting treatment, discussing 

financial arrangements, dealing with cancellations, handling patient statement calls, following up with overdue 

hygiene and calling patients needing to schedule their needed dentistry.

Listed below are some examples of effective communication guidelines:

•	 DON’T SAY: “Would you like to schedule the appointment for the crown/preventive appointment?”
•	 DO SAY: “My next available appointment is Monday at 8:00 or Wednesday at 10:00…which works best 

for you?”

•	 DON’T SAY: “Do you want to pay today?”
•	 DO SAY: “Your fee for today was $______, we estimate your insurance will pay $______, your estimated 

amount due is $ ________...how did you want to handle payment today…cash, check or bank card?”

•	 DON’T SAY: “What day/time is good for you?”
•	 DO SAY: “The next two appointments we have available are…”

•	 DON’T SAY: Do you want to take care of your previous balance?
•	 DO SAY: Including your previous balance of $_______, your estimated payment due today is: $______.

Effective communication is the cornerstone of getting positive results, removing barriers and creating 

successful relationships in a dental practice. 

Lois Banta is CEO, and Founder of Banta Consulting, Inc. and is also the owner and CEO of The Speaking Consulting Network. 

Banta Consulting specializes in all aspects of dental practice management. Lois has over 40 years of dental experience. To 

contact Lois for a personal consultation or to invite Lois to speak to your organization: Office-816-847-2055, Address: 33010 

NE Pink Hill Rd ~ Grain Valley, MO 64029, Email: lois@bantaconsulting.com Website: www.bantaconsulting.com.
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No More Headaches: Tips to Manage Your Insurance Process 
Teresa Duncan, MS, FAADOM

Systems, systems, systems! You hear about systems all the time, but what happens if your system is based 

on a changing premise? That is what today’s insurance and financial coordinators are faced with. Once you 

decide how you will handle primary and secondary insurance in your office, you are faced with new contract 

templates that don’t follow previous guidelines. The way you handled timely filing deadlines must now be 

adjusted since they’ve begun to constrict time periods.

Your focus should be on setting up systems that could (and should!) be re-evaluated for factors such as 

network changes, economic stressors, and staffing changes. The foundation of a solid financial system is built 

by addressing situations that you encounter daily. 

What questions interrupt your conversations with patients? Have you had to:

•	 Stop the conversation to check with the doctor?

•	 Scroll back through the Ledger to see what insurance you filed last time?

•	 Do some quick thinking because a patient complained of receiving less of a courtesy than their neigh-
bor/friend/co-worker? 

•	 Call the insurance company to find out which fee schedule to use?

If you’ve done any of this, you’re not alone. But it doesn’t have to be this way. Think of all the different 

situations that could interrupt your financial or treatment presentation. Then come up with guidelines on how 

to handle these situations. 

As you craft your own financial guidelines, ask yourself basic questions like “which third party finance 

companies do we use?” Then ask yourself more complicated questions like “how do we handle finances when 

a custody decree is in place?” These are the situations that are best to address before you are on the spot. The 

goal is to have no more headaches! 

To receive a copy of a template to help you craft your financial guidelines, email teresa@odysseymgmt.com 

with the subject “Dentrix BDC.”

With over 20 years of healthcare experience, Teresa addresses topics such as Insurance Coding, Office Manager Training and 

Revenue Growth and Protection. Her memberships include the National Speakers Association and the Academy of Dental 

Management Consultants. She was recently named one of the Top 25 Women in Dentistry. Teresa received her Master’s De-

gree in Healthcare Management.
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Learn how to record special dental 
conditions, such as diastemas and  
missing or unerupted teeth.

E
very patient is unique. Making sure a patient’s tooth 

chart accurately represents his or her uniqueness is 

important when you are transitioning from that paper 

document to the digital document. Patients have diastemas, 

missing teeth, unerupted teeth, retained primary teeth, and 

lots of other situations that you want to document on the 

tooth chart. How do you keep it all straight 

and chart it as accurately and quickly as 

possible?

Using the Dentrix conditions is a way that 

you can chart all those unique features 

that you find and want to note. You can 

customize the conditions with different 

paint types, edit the description, and add 

them to your quick buttons for faster 

charting. In this article, I’ll go through a 

few of the common conditions and show 

you what it might look like on the Dentrix 

Patient Chart (Figure 1).

•	 Diastema—The condition for a diastema 
is called “15112 Mesial Open Contact” 
or “15113 Distal Open Contact” in the 
Dentrix Patient Chart (Figure 2). If you 
want to edit the description, in the 
Office Manager, from the Maintenance 

menu, point to Practice Setup, and then 
click Procedure Code Setup. Under 

Procedure Code Category, select Conditions, select 
15112 Mesial Open Contact (or the condition you want 
to change), and then click Edit. Then you can edit the 
description to read “Diastema” if you want.

•	 Missing tooth, closed space—If you have a patient who 
had a four-bi extraction as a child and the orthodontist 
closed the space, you can use the “15000 Mesial Drift-
ing” condition (Figure 2) to show that the space has 
been closed. This could also be used if a patient lost a 
tooth and the teeth have moved into the open spot.
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Charting Special Conditions

Figure 1 Charting conditions in the Dentrix Patient Chart.



•	 Unerupted tooth—If your  
patient has a third molar or 
another tooth that has not 
fully erupted yet, you can use 
the condition “15114 Unerupted 
tooth” (Figure 2). I have seen 
offices either use the U on the 
tooth to mark it or circle the 
tooth. You can choose what 
works best for you. If you want 
to change how it paints on 
the tooth chart, in the Office 
Manager, from the Maintenance 

menu, point to Practice Setup, 
and then click Procedure Code 

Setup. Under Procedure Code 

Category, select Conditions, 
select 15114 Unerupted Tooth, 
and then click Edit. Make the 
desired changes. Make sure you 
use the Paint Type option to 
specify the appearance. 

•	 Retained Primary Tooth—If you 
have a patient with a retained 
primary tooth, then you would 
highlight the tooth, and from 
the Options menu point to Pri-

mary/Permanent, and then click 
Change Selected to just change 
that one tooth. 

Having an accurate picture of your patient’s dentition helps 

with the visual aspect and makes the perio chart more 

accurate. Now that many offices are using the digital record 

instead of paper, it is important that you treat the digital chart 

with as much detail as the paper chart. 

LEARN MORE

To learn more about charting conditions, see the “Charting 

conditions” topic in the Dentrix Help. 

Dayna Johnson, founder and principal consultant of Rae 

Dental Management, helps dental offices improve patient care, 

increase collections, and reduce staff headaches by imple-

menting efficient management systems. With 23 years of 

experience in the business and technical side of dental offices, 

Dayna’s passion for efficient systems is grounded in both 

personal understanding and professional expertise. Dayna can 

be reached at dayna@raedentalmanagement.com or visit her 

website at www.raedentalmanagement.com. 

DAYNA JOHNSON
Certified Dentrix Trainer

Figure 2 Conditions in the 

Patient Chart Procedure 

Codes list.
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Discover the three IT prongs you need to 
support digital dentistry.

A 
diamond ring can be a symbol of beauty, elegance 

and class. A common way to display a diamond is 

on a ring with a prong setting, with metal claws that 

grip the diamond tightly, holding it in place. You probably 

wouldn’t buy a spectacular diamond for thousands of 

dollars—and then mount it with flimsy tin prongs. You want 

a strong setting that will support your diamond and keep it 

from falling off. Just like that expensive diamond, your 

digital dental equipment is a significant investment and 

needs the right IT infrastructure to support it so it will work 

the way it was designed. Without the right “setting,” you 

could lose everything. 

Digital dentistry has unique needs. Since a local IT company, 

or your computer-savvy nephew, probably won’t understand 

those needs, it could take years to train them to effectively 

support your practice, resulting in frustration and reduced 

productivity. It is important that your digital practice has 

that strong setting from an experienced IT company, like 

Henry Schein TechCentral. TechCentral has more than 15 

years of experience serving the dental and health-care 

industries with a three-pronged approach to providing IT 

hardware, support and data protection/preservation.

Prong 1: Hardware

Your high-end dental imaging equipment and practice 

management software is only as good as the supporting 

technology. Your dental practice needs an IT provider 

who understands how dental equipment and software 

works with workstations, servers, printers, scanners and 

peripheral devices. TechCentral has relationships with 

several technology manufacturers, working with them to 

pre-configure and test each unique solution to help provide 

peace of mind that you’re getting the right equipment for 

your dental environment.

Prong 2: Support

How many thousands of dollars would you lose if your 

computers went down, even for a few hours? TechCentral 

can help decrease the likelihood and amount of costly 

downtime issues with support that’s available when you 

need it. With prompt remote assistance from experienced 

dental technology professionals, as well as on-site 

technicians, if needed, TechCentral can help keep your 

practice running smoothly. 

Prong 3: Data Protection

No single defense can protect your patient data completely 

from computer attacks. Used as part of a comprehensive 

security plan along with antivirus software, digital dentists 

should use a firewall. TechCentral provides WatchGuard 

appliances for an advisable extra layer of data protection. 

In the event your data is compromised, TechCentral Hybrid 

Backup Services provides a redundant, remotely managed 

backup and recovery solution both on a local backup device 

and in the cloud. 

The Right IT Provider

TechCentral lets dentists go back to taking care of patients 

instead of worrying about technology problems. TechCentral 

is an end-to-end IT provider specifically for the dental 

market, delivering the strong “setting” your digital practice 

requires. Request a free comprehensive on-site network 

assessment performed by a TechCentral technology 

professional, who will evaluate all your equipment and 

systems and help you identify vulnerabilities and solutions. 

Visit www.henryscheintechcentral.com/digitaldentistry or 

call 844.588.6578.  

Certain components of the products or services described 
above are provided by third parties. Henry Schein, Inc. and 
its affiliates are not responsible for, and expressly disclaim, 
all liability for damages of any kind arising out of the use of 
those third-party products or services.

T
e

ch
N

o
te

s

Making Your Digital Dentistry Shine

DAVID BROOM

Senior Director of Product Management,  
Henry Schein TechCentral 



To learn more about the TechCentral Hybrid Backup solution, 
visit www.HSTechCentral.com/Backup/WaterDamage
or call 844.588.6578

WE’VE
GOT YOUR 
BACKUP

Water damage can happen at any time. TechCentral Hybrid 

Backup creates redundant backups so that your critical data is 

potentially recoverable from two AES 256-bit encrypted locations. 

Don’t worry because we’ve got your backup in the event of 

disaster, hardware failure, and even an oversized sea monster.

TechCentral—Hybrid Backup
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ImageRamp and Dentrix: 
Easily Scan to the Dentrix Document Center 
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imagn® and Dentrix: Strengthening 
Practices and Improving Patient Care  
with Dental Sleep Medicine

Learn how to easily implement Dental 
Sleep Medicine in your practice.

A 
consistent lack of quality sleep can have 

devastating effects on your patients’ health. 

From bruxism to sleep apnea, a variety of 

ongoing sleep problems can affect people from all 

walks of life. imagn and Dentrix have created an 

integrated solution that will enable you to easily 

implement dental sleep medicine into your practice by 

removing the obstacles you may face while navigating the 

medical field. You can be the hero! Solve your patient’s 

sleep problems while your dental practice flourishes. 

Why Focus on Sleep?

We all know our country is in the middle of a health 

crisis, and chronic illnesses are at epidemic levels. Your 

patients may be affected by poor health that impacts their 

relationships, finances, work, daily decisions, and much 

more. Why is health spiralling downward while we have such 

an advanced health care system?

Health is a complicated process, but good sleep provides 

an important foundation for overall health. A good night’s 

sleep can make a difference. And as a dentist, you can help 

your patients improve the quality of their sleep. Good sleep, 

combined with diet and exercise, can help any of us make 

huge strides to improve overall health.

Dentists can have a huge impact on our population’s 

health because of the number of patients they see in their 

practices. By adding dental sleep medicine, dentists can 

directly affect health as much as any other health provider. 

Appliance therapy for the night and day supports the health 

of the oral cavity, the airway, and the surrounding structures. 

Fifty percent of the signs and symptoms of sleep disorders 

express themselves in the mouth—an area where the 

dentist specializes. Dentists must understand airway health, 

help patients prevent pain, and reinforce proper habits to 

promote good sleep and healthy lifestyles. Dentists who 

provide conservative, preventative, and effective solutions 

to improve sleep can help their patients decrease the 

amount of medication taken and surgery needed. Now is 

the time to learn about how dentistry can prevent decades 

of health issues from piling up due to poor sleep!

Your Dental Practice and Medicine

imagn works in tandem with Dentrix to provide a seamless 

solution to simplify implementing dental sleep medicine 

into your normal patient care tasks. Medical charting and 

the medical billing process require additional software to 

keep everything easily accessible. Dentrix and other practice 

management software does not include all the features 

needed to manage sleep medicine effectively. The imagn 

sleep module provides screening questions, creates medical 

notes, coordinates sleep testing and referral information, 

and bills medical insurance. imagn sleep also guides the 

staff and doctor through the process and identifies what 

comes next for each patient (Figure 1).

Once it is installed, you can access the imagn sleep module 

from the Dentrix Patient’s Chart. The imagn sleep tab is next 

to the Clinical Notes tab at the bottom of the Patient Chart 

(Figure 1). When you click this tab, the imagn sleep panel 

displays the current status of the process and gives you 

the tools to complete the necessary steps. With electronic 

tablet data collection, electronic signature capture, and 

encrypted email communication, imagn provides the digital 

tools you need without leaving Dentrix so you can focus on 

what you do best, comprehensive dental care!

The first step starts in hygiene. Just what the hygienists 

want to hear, right? One more thing for them to cover in 

their already tight appointment schedule. However, Dentrix 

and imagn have streamlined the process of screening, 

SOLUTION SPOTLIGHT

Figure 1 The Imagn panel integrates with the Dentrix Patient Chart.

DR. JOE MAGNESS, DDS, AADSM, ASBA
CEO, imagn Solutions
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and it truly only adds a minute or two. Again, the hygienists 

never need to leave the Dentrix Patient Chart! Using imagn’s 

proprietary sleep screening, you can quickly and easily identify 

the patient’s likelihood of having a sleep disorder (Figure 

2). This screening process includes an automated intraoral 

and extraoral exam and compiles a clinical chart note that is 

accepted by medical insurance. Best of all, you did not have to 

write the additional note for insurance. 

The only way for a patient to get diagnosed for sleep apnea 

is to have an overnight test and be diagnosed by a board-

certified sleep specialist. Dentists cannot diagnose sleep 

apnea. Rules and regulations on sleep testing are state 

specific, but in all states a dentist can identify potential 

candidates and recommend sleep testing. In our experience, 

the most successful offices own home sleep apnea testing 

devices and send their patient’s home with a comfortable, 

easy-to-use device that they wear in their own bed. There 

are also multiple options that include mail order, home 

delivery, and local sleep labs for other solutions for testing. 

You can also refer a patient to a local sleep specialist. 

imagn streamlines the process by coordinating the testing, 

integrating with the sleep device company to automate 

the display of the results, and sending the diagnosis and 

prescription to the medical insurance. Our software can 

input the sleep test information directly into imagn without 

increasing your staff’s workload. 

The imagn software also includes an integrated medical billing 

platform which takes out the biggest stumbling block that 

offices face with medical billing. You can do it yourself or use 

the one-click medical billing process, leaving all the worry 

to a third-party partner. All data exchange is electronic and 

does not require a fax, email, or even phone calls. The medical 

billing display gives you a current status of pre-authorizations 

and claims. 

imagn has advantages over other insurance billers because 

imagn can handle attachments and uses the efficiency in the 

software, thereby saving time and money. imagn medical billing 

platform can bill medical insurance for any procedure, not 

just for dental sleep medicine. Dental offices perform many 

other procedures that could and should be billed to medical 

insurance. Use imagn’s medical billing platform with Dentrix 

to increase revenue and maximize your practice’s potential 

(Figure 3). 

When you are ready to refer a patient to a local 

provider for a sleep study, the referral wizard will 

generate faxes, secure emails, or print documents 

in seconds. Each can be customized as needed. 

The wizard saves time and provides your team 

with referral documentation at their fingertips. The 

software handles the increased communication 

needed to collaborate with medical partners and 

removes the communication hassle that can occur 

among providers, insurance companies, and patients.

Your team is already asked to do a lot. To be 

successful with dental sleep medicine, you need 

software that is effective and efficient. You need 

the information on demand. You need to be able to 

evaluate how the practice is doing as well as what’s 

next for your patients and how their health is trending. imagn 

sleep software automates the process as much as possible 

and enables you and your staff to tap into the next wave of 

dentistry without being saddled with extra work. 

The future for a thriving dental practice includes being an 

integral part of a patient’s overall health plan, and that starts 

with improving their sleep. Helping your patients improve 

their sleep will improve their oral health as well as their overall 

health. Dental sleep medicine will strengthen your practice and 

increase your revenue. imagn and Dentrix can help you manage 

the process without adding to your or your staff’s workload. 

Quality sleep gives all of this the best chance to happen. Sleep 

changes everything.® 

The product(s) and/or service(s) described herein are provided 
by a third party and the content and descriptions were 
created by such third party. Henry Schein, Inc. or its affiliates 
(“HSI”) make no independent assessment of the content and 
descriptions provided by such third party. HSI is not responsible 
for, and expressly disclaims all liability for damages of any kind 
arising out of such third party products or services.

Figure 2 The imagn 
dashboard.

Figure 3 The imagn medical billing screen.
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You already depend on Dentrix to make your practice more profitable and productive. Now, you can turn 

Dentrix into an even more powerful solution by adding trusted, fully integrated third-party applications 

and capabilities to your digital dental office. The Dentrix Connected logo means the product has been 

carefully developed, tested and certified to work with your Dentrix platform. To see the full list of Dentrix 

Connected applications visit www.Dentrix.com/Connected today.

SOLUTION GUIDE

Broadview
www.broadviewnet.com

Network-based Business 
Communication
Make your practice more profitable with 
OfficeSuite Dental, the state-of-the-art 
phone system that fully integrates with 
Dentrix G5.

BiteBank Media
www.bitebankmedia.com

Dental Practice Solutions
Streamline your practice with custom 
dental websites, appointment 
notification and scheduling, real-time 
booking, patient education videos and 
reputation management.

DocuFi
www.docufi.com

Document Management Solutions
DocuFi™ is a certified Dentrix partner 
providing tools to capture and process 
documents into electronic digital form. 
ImageRamp™ for Dentrix, using Fujitsu 
scanners, offers the most productive 
document scanning solution for Dentrix.

Apteryx
www.apteryx.com 

Dental Practice Solution
Apteryx exceeds the expectations of its 
customers by creating timely, innovative 
and cost effective software solutions 
that improve the profitability of the 
clients’ businesses. 
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3Shape
www.3shape.com

TRIOS Scanner
Take advantage of the award-winning 
TRIOS intraoral scanner to enhance patient 
experience, reduce chair-time and unlock 
the widest range of treatment opportunities. 
Backed by continuous software updates, 
upgradable hardware and add-on treatment 
modules, TRIOS ensures your practice stays 
ahead and your business grows stronger.

DDX
www.ddxdental.com

Digital Dental Exchange
We provide next generation lab case 
management. Save time and boost 
efficiency, store patient data more securely, 
and improve communications with your lab. 
Call 877.244.9345 to schedule a demo or 
speak to a live sales representative.

Apteryx
www.apteryx.com 

Dental Practice Solution
Apteryx exceeds the expectations of its 
customers by creating timely, innovative 
and cost effective software solutions 
that improve the profitability of the 
clients’ businesses. 

3M
www.3m.com 

True Definition Scanner
The 3M™ True Definition Scanner—
available in mobile or cart editions—
offers unparalleled accuracy, ease of 
use, and affordability for making fast, 
precise digital dental impressions. 

Broadview
www.broadviewnet.com

Network-based Business 
Communication
Make your practice more profitable with 
OfficeSuite Dental, the state-of-the-art 
phone system that fully integrates with 
Dentrix.

Brightsquid
www.brightsquid.com

Secure-Mail
SecureMail is the patient-centric platform for 
secure healthcare collaboration. Thousands 
of physicians, specialists, allied health 
professionals, and patients are improving 
quality of life and overall care by sharing 
Protected Healthcare Information securely 
and efficiently with Brightsquid Secure-Mail.
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DentalWriter
www.dentalwriter.com

Medical Billing Software
For over 25 years, Nierman Practice 
Management has led medical billing in 
dentistry by continuously developing 
innovative products and providing 
exceptional training for dentists looking 
to grow their practice.

DocuFi
www.docufi.com

Document Management Solutions
DocuFi™ is a certified Dentrix partner 
providing tools to capture and process 
documents into electronic digital form. 
ImageRamp™ for Dentrix, using Fujitsu 
scanners, offers the most productive 
document scanning solution for Dentrix.

DEXIS
www.dexis.com

Digital Diagnostic Imaging 
DEXIS delivers innovative, high-quality 
digital imaging solutions to the dental 
community. With its state-of-the art  
sensor and easy-to-use imaging 
software, Dexis provides numerous 
benefits to you, your practice, and your 
patients. 

Demandforce
www.demandforce.com

Patient Communication Solution
Demandforce works seamlessly with 
Dentrix G5 software to automate 
online and offline communications with 
existing patients to improve in-office 
efficiencies. 

Dental Symphony
www.dentalsymphony.com 

Dental Practice Solution
Dental Symphony’s web-based 
clinical software revolutionizes patient 
management. Working alongside 
Dentrix, Dental Symphony provides 
innovative tools to practice easier,  
safer and more efficiently. 

eDossea
www.edossea.com 

Intra-Office Communication
We are solely focused on the dental 
profession and within the dental 
profession on the secure, easy and 
inexpensive transfer of your client’s 
medical records from one office to 
another. This is all we do. 

Panda Perio
www.pandaperio.com

Periodontal Practice Solution 
The complete clinical digital record 
for Periodontal practices. Charting, 
comparison reporting, treatment 
planning, automated chart notes, and 
much more. Save hours of admin time 
and unify your front and back office. 

Lighthouse
www.lh360.com 

Patient Communication Solution
Lighthouse 360 is a comprehensive 
automated patient communications 
system designed exclusively for dentists. 
It uses email, two-way text messaging, 
automated phone calls, postcards and 
letters to reach your patients. 
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innovative tools to practice easier,  
safer and more efficiently. 

eDossea
www.edossea.com 

Intra-Office Communication
We are solely focused on the dental 
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inexpensive transfer of your client’s 
medical records from one office to 
another. This is all we do. 

Jakari Care
www.jakaricare.com

Patient Health Information
Less work. Better care. Let our HIPAA-
compliant solution automatically collect, 
analyze and transfer patient medical 
history, treatment goals and other 
important information into Dentrix. 

Jakari Care
www.jakaricare.com

Jakari Care
www.jakaricare.com

imagn sleep software
We’ve spent years researching the best 
method of implementing sleep in dental 
practices. Now you can take advantage 
of our complete sleep solution to enrich 
the lives of your patients and add new 
revenue streams to your practice. 

imagn
www.imagnsolutions.com

Lighthouse
www.lh360.com 

Patient Communication Solution
Lighthouse 360 is a comprehensive 
automated patient communications 
system designed exclusively for dentists. 
It uses email, two-way text messaging, 
automated phone calls, postcards and 
letters to reach your patients. 
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Protected Trust
www.protectedtrust.com 

Protected Trust
Protected Trust offers simple and 
secure email encryption and identity 
verification that protects your patient 
health information (PHI) by ensuring 
privacy and HIPAA compliance. 

RecordLinc
www.recordlinc.com 

Patient Communication Solution
RecordLinc is the largest professional 
network of dental professionals in 
the world. Securely and easily send 
electronic referrals, patient transfers, and 
track treatment plans between dental 
practices in a HIPAA-compliant portal. 

Planmeca
www.planmeca.com

Planscan
Planmeca Romexis® is an advanced, 
easy-to-use software suite providing 
a rich set of tools to meet the imaging 
requirements set by any dental facility – 
from a small clinic to a large hospital. It 
supports the most versatile range of 2D 
and 3D imaging modalities. 

Podium
www.podium.com

Podium
Stop the guesswork and know what your 
patients are saying. With Podium, you 
can impact what’s said, where things are 
said, and how things are said. Podium 
helps over 3000+ organizations take 
full control of their online reputation. 
Podium can help you, too. 

Patient Activator
www.patientactivator.com 

Patient Communication Solution
Patient Activator, part of Los Angeles-
based 1-800-DENTIST®, is the leading 
social media optimization and patient 
communications service dedicated to 
the dental profession. 

LocalMed
www.localmed.com

LocalMed
LocalMed is a live online scheduling 
platform that fully integrates with 
Dentrix to provide new and existing 
patients online and mobile scheduling 
access 24/7.

Practice Safeguard
www.practicesafeguard.com 

Web-Based Fraud Monitoring
A web-based financial monitoring tool for 
Dentrix users that deters fraud and costly 
errors by alerting any device you carry to 
unusual transactions in real time.

Practice Mojo
www.practicemojo.com 

Patient Communication Solution
PracticeMojo creates proven campaigns 
that help dental practices recruit, retain 
and reactivate patients automatically, 
using email, text messages, automated 
phone calls and mailed postcards.

Personable
solutions.personable.com 

ScanWriter
Want to know how profitable your practice 
can be? Use ScanWriter® Dentrix Edition to 
seamlessly integrate your Dentrix® data into 
QuickBooks (and other accounting software) 
and to improve your practice. You can 
automate your accounting process easily now 
for real time monitoring of financial health  
and key performance indicators. 



Transparent Aluminum
www.transparentaluminumllc.com

Dental Practice Solution
Transparent Aluminum is a company 
focused on creating custom workable 
solutions for practices to get the most 
out of their Dentrix database. 

Updox
www.updox.com

Updox Central for Dentrix
Updox is the industry-leading healthcare 
connectivity solution, offering dentists and 
practices a cohesive suite of services so 
practices can focus more on patient care and 
less on managing multiple platforms. With 
Updox, practices can lower costs, increase 
revenue, improve workflow, maximize staff 
time and increase efficiencies.

Reputation
www.reputation.com 

Patient Communication Solution
Reputation.com’s platform enables 
dentists to see all their online reviews 
in one space and use the platform’s 
analytical tools to understand the 
broad themes that emerge from 
patient feedback. 

Yapi
www.yapicentral.com

Dental Practice Solution
Started as the first fully integrated 
intra-office communication software, 
YAPI has grown into a comprehensive 
suite of innovative automation solutions 
designed around unique needs of 
dental practices. 

YAPI

U.S. Health Record
www.teamlinks.com

Intra-Office Communication
Teamlinks EHR was created to foster 
interdisciplinary collaboration on 
patient health information with the goal 
of connecting the health care team and 
the patient. 

Sesame
www.sesamecommunications.com 

Patient Communication Solution
Sesame Communications helps dental 
and orthodontic practices harness the 
power of the Internet to accelerate new 
patient acquisition, build patient loyalty 
and transform the patient experience. 

Simplifeye
www.simplifeye.co 

Simplifeye
The #1 mobile experience for dental 
providers, Simplifeye connects you, your 
patients, and your business in amazing 
ways via state-of-the-art consumer tech. 
Say goodbye to inefficiency and hello to 
a whole new way of running your practice. 

The product(s) and/or service(s) described herein are provided by a third party and the content and descriptions were created by such third party. Henry Schein, Inc. or 
its affiliates (“HSI”) make no independent assessment of the content and descriptions provided by such third party. HSI is not responsible for, and expressly disclaims 
all liability for damages of any kind arising out of such third party products or services.

TeleVox
www.televox.com

Patient Communication Solution
TeleVox Software is a high-tech 
engagement communications company, 
providing automated voice, email, text 
and web solutions that activate positive 
patient behaviors through the delivery 
of a human touch. 

Solutionreach
www.solutionreach.com

Patient Communication Solution
Smile Reminder provides patient 
engagement and communication 
solutions for healthcare practices. 
Utilizing the latest text, email, voice, 
video, web, and social media tools to 
communicate with customers.
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is better than ever

Discover how the latest Dentrix G6 can 

help you improve your practice. See 

demos of new user-requested features 

that can help you improve your processes 

and profitability. Use your active 

Customer Service Plan to claim your 

free upgrade today, and prepare now for 

Dentrix G7, coming in Spring 2018.

Visit  Dentrix.com/G6  
to see the newest features  

and start your upgrade.
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Henry Schein Practice Solutions
1220 South 630 East, Suite 100
American Fork, Utah 84003

DATA CAN TELL YOU 
WHAT’S RIGHT AND 
WRONG IN YOUR 
PRACTICE

IMPROVE YOUR PROFITABILITY
Meet with a Dentrix Profitability Coach for a free 30-minute 
assessment. See what your data says about your practice’s 
strengths and weaknesses, and key areas to improve to 
immediately boost profits. Act now.

SCHEDULE YOUR FREE PRACTICE ASSESSMENT NOW AT

DENTRIX.COM/DENTRIXMAGCOACH

TIME TO 
START  
LISTENING


